Carlson Tip of the Day.. Wiped
Out Property Corner Symbols

I get this question quite a lot and thought it would be a good
topic for Tips of the day..

Problem: Lines or polylines of a boundary show up inside your
open property corner symbols. See the image below for an
example:

The additional problem is that, if you trim the lines inside the
symbols to make it look cleaner, you're actually modifying the
length of property lines so the distances from corner-to-corner
are no longer accurate.

Here’s an alternative: You can download a modified set of
Carlson’s point symbols that include a “wipeout” entity that
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hides the lines behind/underneath the open symbols instead of
trimming them and changing the length of the lines. Using the
new set of symbols, the same property lines and symbols look
like those in the image below (notice that the distances of
linework are unchanged):

How to do this?

Here is the knowledge base article on Carlson’s website that
includes a ZIP file with the new symbol DWG files and
instructions on where the files must be saved.
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Carlson Survey 2015 with
Embedded AutoCAD has been
released

MAYSVILLE, Ky., U.S.A. (August 13, 2014)- Carlson Survey 2015
OEM is an easy-to-use, intuitive software. Its newest update
provides upgrades to the 3D viewer that allows users to apply
textures, animation, surface updates, even record movies and
import Sketch-Up objects. The software’s popular field-to-finish
feature has also been enhanced for 2015 to allow surveyors to do
coding on pipe networks that then allows them to build a network
of pipes.

Together with Carlson Survey 2015 version, which works on

AutoCAD® versions 2007 to 2015 and comes with the improved

IntelliCAD® 8.0 built-in, Carlson Survey OEM is the number one
office software solution for surveyors in the United States.
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Read the rest of the press release
Request a 30-day trial

Request a live demonstration
Request a custom proposal

See these products in our Online Store

Carlson Tip of the Day.. List
of 1improvements 1in Carlson
2015 programs
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General

= AutoCAD 2015 — Added support for this new version.

» IntelliCAD 8.0 — Direct support for 2013 DWG file format.
Added 64-bit version. New features including support for
dynamic entity reactors, layer states and improved
ddvpoint interface.

» Google Earth — Added support for exporting 3D Faces.

» Import 3D View Model File — New command to create drawing
entities from a 3D model file.

 Export 3D View Model File — New command to create a 3D
model file from selected drawing entities.

= 3D Model Library — New command to prepare the 3D models to
use in the 3D Viewer commands.

= Toolbar Manager — New command to save status of toolbars
and allow migrating toolbar settings between versions.

» File Selection — Added list of subfolders within current
folder and button to move up a folder level. Added option
for warning when selecting a data file that is not within
the current project folders.

» Textures — Added 40 new textures for 3D viewing.

» Settings File Manager — Added function to compare two
settings files and report differences.

 Leader With Text — Added option for horizontal tick and
option to create with Mtext.

=Join Nearest — Added filters for common colors and
linetypes.

= Join Polyline By Trace — New command to join linework into
a polyline with prompts at intersections

Survey Commands



» Field To Finish — Added special pipe feature coding with
ability to create pipe network (.sew) file. For tree
feature coding, added option for drip as diameter instead
of radius, added option for solid circle for trunk and
option for relative tree size for the symbols. Added
control for separate layers for the point attribute block
and point node. Added new AFIT special code for making a
curve tangent through a series of three curve points.
Added method for dynamic templates with variable
horizontal and vertical offsets by using the OH and 0OV
special codes. Added settings file default distinct point
layer prefix/suffix. Added separate text size settings for
attribute text labels and point block attributes.

= SurvNET — Added error report for individiaul observations
to track down blunders. Added import for TDS GPS vectors.

» Edit Process Level Data — Added support for processing
with zero horizontal distances.

= Carlson Cloud — New command for communicating with SurvCE
for sending messages, data files and crew locations.

= Report Distance Scale - Added methods for grid/ground
factors on-the-fly in addition to a fixed factor.

= 3D Transformations — Added 3D coordinate transformations.

= Point Group Manager — Added method to create point group
by offset distance from alignment polyline.

= Move Point Attributes With Leader — Added controls for
attribute order and ability for curved leaders.

= Import Text/ASCII File — Added method import from text
with fixed widths and method to use inclusion/exclusion
perimeters.

» Legal Description — Added method to report station/offset
using a reference centerline. Added method for reporting
with geodetic mean angle and geodetic distances.

» Cut Sheet — Added method to get station/offset from the
point description coding. Added field for design point



description.

» 0ffset Points By Interval — New command to create offset
points along an alignment.

Label Coordinates — Added options to include a
description, to use Mtext, to draw the labels at an angle
and option for mleader.

Draw Legend — Added method to put each symbol or a
specific layer.

Civil Commands

Draw Profile — For paper space profiles, added method to
use an existing layout as a reference template for the new
layout. For the horizontal label box, added option for
horizontal text in addition to vertical. For pipe
profiles, added settings to label inverts by left/right
order, added option to draw cutoff style pipe extensions,
added option to create labels as MText, added option for
flow arrow in middle of pipe, new option for labels above
the pipes, added justification settings per label, added
setting for separate layer for pipe thickness than pipe
profile and option to connect rims with a polyline for a
simple surface profile. For Label Line/Point crossings,
added option to label elevations at crossings, added
method for labeling GIS attributes, added method to label
points of selected descriptions within offset tolerance,
added option to label CL deflections and added option to
avoid label overlaps. Added special CL stations for break
point station/elevation labels plus new prefix/suffix
settings. For EOP profiles, added new break point and EOP
leader style to the start of the labels, added option to
label ground profile on road EOP profiles and added
controls to select which profiles are EOP, road and



ground. For the manhole name within circle option, added
setting to put the name and number on separate lines and
added the option to auto shift the labels to avoid
overlaps.

Draw Sections — Added option to label cut/fill volumes per
station. Added separate settings for pipe crossing layers
for decimals on pipe size, offset and elevation.

Draw Plan View Sheets — Added option to set station range
to draw.

Input-Edit Centerline — Added Fit Curve method to apply
speed table to all PIs in centerline.

Input-Edit Profile — Added method to apply speed table for
vertical curve lengths to all PIs in profile.

Label Station/Offset — Added method to use a TIN or grid
surface for the elevation reference.

Draw Lot Setback — Added method for separate corner side
setback amount.

Move Spot Elevations — New command to move spot labels and
update elevation to new position on reference surface.

Line Of Sight Viewshed — New command to calculate line-of-
sight from a point and eye height on a surface.

Draw Spot Elevations — Added option for label only and
option to pick an entity instead of a point.

Cut/Fill Labels — For points method, added more options
like separate layers for existing and design. For the TIN
method, added options for deep cut/fill labels and option
for marker symbol.

Smooth Polylines — Added method to smooth polyline between
selected points.

Triangulation File Utilities — Added function to color TIN
within inclusion perimeter.

Road Stripe Library — New command to setup named sets of
road stripes with offsets, colors and styles.

Draw Road Stripes — New command to draw linework for road



stripes.

= Linear 3D Object Polylines — New set of commands to manage
alignment polylines for 3D Viewer commands for linear 3D
features such as fences or guard rails.

= Label Profile On Centerline — Added label position by
left/right in addition to above/below. Added prefix/suffix
and station interval settings.

= 0ffset 3D Polyline By Grade Table — New command to offset
a 3D polyline using the distances and slopes from a
template grade table.

= Road Network — Added settings for station range to process
for each road.

= Mass Haul Analysis — For borrow pits, added offset from
road to account for offset travel time.

= Sections From 3D Polylines — New command to create cross
sections from 3D polylines.

= Surface 3D Viewer — Added option to show contours. Added
functions to edit triangulation by swapping edges, adding
breaklines, removing points, removing triangles or editing
point elevations.

= Surface 3D Flyover — Surface model is kept in sync with
any edits in CAD so that the 3D view is automatically
updated. Added method to add models to the scene by screen
picking plus the ability to pick models in the scene to
edit properties (location, rotation, scale). Added
function to record a movie. Added method to map textures
by color and method to scale textures. Added run view mode
for detached from moving vehicle. Added option to show
contours. In pick mode, display real-time coordinate and
elevation for mouse position on surface.

= Motion 3D Viewer — New command to assign path polylines
with speeds to 3D models and the camera.



Hydrology Commands

 Design Detention Pond — New command with all steps for
detention pond design plus support for multiple rain
events.

» Pipe Culvert Design — Added method for tailwater by
channel or discharge rating and added overtopping
analysis.

= SCS Rainfall Library — New command to define an SCS data
reference library for rain events.

= Rational Rainfall Library — Added import of IDF tables
from comma separated text files.

» Collision Conflict Check — Added support for checking
unlimited pipe networks and using the report formatter.

 Sewer Network Design — Added option for junction loss for
pipe connections including laterals. Added method for
tailwater at each outlet. New method to set symbol
rotation by screen pick. Added graphic preview during .sew
file selection.

 Lateral Design — Allow for multiple lateral connections at
manholes.

= Identify Pipe Polylines — New command to ID or list pipe
data assigned to 3D polylines.

= Import Network From 3D Polylines — Added method to control
order of names by design order, elevation or polyline
direction. Added method to set rim elevation by depth.

GIS Commands

= Label GIS Point Data — New command to create text labels
or block with attributes for selected GIS attributes.



Field Commands

 Drivers: Upgraded many drivers from the SurvCE updates.

Geology Commands

= Define Mining Model — Added Mine Model collection of
surfaces for modeling only mineable strata already
adjusted for recovery, roof/floor gain/loss and minimum
parting. Renamed “Pre-Calc Model” to “Geologic Model”.

» Geologic To Mining Model — New command to adjust a
Geologic Model to make a Mining Model.

»Drillhole Database — Added support for MS Access .accdb

format.

= DHDB — Added drillhole database import/export to DHDB
format.

= Import From Coal Section — New command to create

pit/channel samples from coal sections.

» Configure Section Info — Added method to set folder for
section drawing to allow storing the section info on a
server.

» Import/Export Coal Sections From Text File — New commands
to import/export coal sections from/to text files.

» Grid Files — Added option to store .grd files as binary to
improve read/write speed.

»Grid File Utilities — Added method to call other GFU
macros and pass parameters from another macro. Added sin()
and cos() functions for grid math. New dialog interface
including dialog for creating IF statements. Added 3D
window to show grid while modified.

» Draw Geologic Column — Added method to draw in 3D with
strata sections sized based on grade parameters. Also
added 3D draw method as 3D lines. Added method to label
grade names and added separate layer settings for



attribute labels. For labels in 3D, added options for
rotate labels vertical and draw label leaders. 3D Viewer
Window now shows 3D text generated by Geologic Column.

= Drillhole Report — Added method to report grades for each
strata.

= Drillhole Core Images — Added method to draw the report to
the drawing and added option for labeling depth or

elevation.

Draw eLog — New command to draw graph of selected
attributes from an eLog LAS file.

»Create Drillhole from eLog — New command to create
drillholes with strata classification using the elog
paramters.

= Trim Isopach Within Fault Zone — New command to isopach
elevations and break contours at fault zones.

» Draw Fault Labels — New command to label fault deltas.

= Draw Fault Symbols — New command to draw +/- symbols for
faults.

= Apply Faults To Grid — Added method to handle thrust
faults. Added method for processing multiple grids at a
time.

= Surface Mine Reserves — Added Adjust Pits Manager for
adjusting pit perimeters with real-time quantity updates.

Draw Grade Boundary — New command to draw boundary
polylines around area with specified grade.

» Block Model Statistics — Added min/max/average elevation
and depth to the report. Added level # to report name.

Surface/Underground Mining Commands

» Ribbon — Added a mining ribbon for running with AutoCAD
2012 and higher.

» Import Pit Points — Added method for user-defined input
file formats.

= Import Polyline File — Added method to draw 3D polylines



from sequence of top/bottom points for blast holes.

» Label Property Lines — Added option to label owner or id
labels and added setting for label layer.

» Surface Equipment Timing — Improved calculation speed by
25%. Added method to use table of production targets with
variable equipment usage to adjust to meet the targets.

= Underground Timing — Added option for transparent hatching
and for buffer hatching.

= Dozer Push — Added support for push cut area by closed
polyline. Added method for reporting single, average push.
Added option to keep existing polylines, to draw centroid
symbol and to label total push distance. Added settings
for label text size, layer, style, decimals and prefixes.

» Regrade Backfill — Added bench option to cross section
regrade design.

» Range Diagram — Added dimensions for all angles and
distances. Added options to output final profile and to
output parameters to sequence file.

= Design Ramp Profile — New command to create a ramp profile
between two surfaces.

= Ramp Bench Polyline Generator — New command to design
bench pits using polylines.

 Edit Dragline Sequence — New command to edit the steps for
pit cuts.

- Make Solid From Points — New command to create a solid
model from a cloud of points.

= View Solid — New command to view a solid model in the 3D
viewer.

»Draw 3D Mine Model — Added method to make model from coal
sections and pillar/perimeter polylines.

»View 3D Surface History — Added support for displaying
TINs.



Construction Commands

» Define Layer Target/Material/Subgrade — Added support for
up to 7 subgrades.

= Color TIN By Layer — New command to color the surface TIN
using the color assignments in Define Layer Target.

= 3D Drive Simulation — Added method to apply textures to
design layers in addition to colors for viewing in 3D.

= Tag Segments To Skip Linear — New command to tag polyline
segments to skip for material linear quantities.

CADNet Commands

» Merge Raster Files — Added method to automatically select
control points.

» Import SketchUp File To Drawing — New command to create
drawing entities from a SketchUp file.

= Import PDF File — New import engine with ability to use
layers for PDFs with layers.

= Drawing to 3D PDF — New command to create a 3D PDF from
selected drawing entities.

= 3D Viewer to 3D PDF — New command to create a 3D PDF from
a 3DX file from the 3D Viewers.

Point Cloud Commands

» Faro — Added direct import method uses Faro toolkit.

= E57 — Added support for importing industry standard e57
format.

» PLY — Added import for PLY format.

» LAS — Added method to use LAS classification for coloring
and selection.



Data Conversions

= 12D — Added import and export for pipe networks plus
support for some more entity types.

= Canada — Added support for NTv2-NAD27-83

» Geoids — Added support for Canada CGG2010 and CGG2013n83,
Sweden 08 rh2000, Sweden 08 rh70, Poland 2011 and Georgia
2012

» Towa — Added projections for Iowa Regional Coordinate
System

» Ireland — Added national grid projection.

» KOF — Added function to draw linework from KOF files.

= MDL — Added support for binary data within FSC file.

 Norway — Added support for N2000 format.

= SketchUp — Added import for SketchUp models in Surface 3D
FlyOver

» SurvCE — Added import for points with photos in Google KML
format as created by SurvCE

Carlson 2015 Has Been
Released!

Carlson posted the 2015 versions of their for CAD (IntelliCAD or
AutoCAD 2004-2015) on Tuesday afternoon.. you can Download
Carlson 2015 products with IntelliCAD here. The 2015 versions of
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embedded AutoCAD products (Survey and Takeoff OEM) will be
released later this summer.

If your maintenance contract is current or you have purchased
2014 products within the past 90 days, you'’re automatically
eligible for an upgrade to 2015. Click here to look up your 2015
serial number using your 2014 serial number.

Click here to review the list of all improvements
Click here to read about updates in Carlson Survey 2015

Click here to read about updates in Carlson Civil and Carlson
Hydrology 2015

Click here to read about updates in Carlson Takeoff Suite 2015 —
including Construction, CADNet, Trench and GeoTech

There are price increases with 2015 products. Click one of these
links if you would like to Request a Demonstration or Request a
Custom Proposal to upgrade to 2015 or purchase new software.

Please follow this link to see if you're eligible for our
monthly webinars including CAD and Carlson Tips & Tricks, Intro
to Survey and GIS and What’s New in Carlson 2015.

New Update for Carlson Survey
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2014 with Embedded AutoCAD
(OEM) 1s available

Carlson Software posted a new build with updates to Survey 2014
with embedded AutoCAD on 7/14/2014. The latest build can be
downloaded here: Carlson Software Downloads Page.

To find your current “build”, open your Carlson desktop software
and go to the Help menu and click About Carlson. The current
build is listed on the top line in the text window and
corresponds to the date it was posted. For instance, the build
shown below — 140211 — was released on Feb 11, 2014.

[Carlson 2014, build 140211 ?

| Copyright (c) 1983-2013 Carlson Meftware.
|All Rights Reserved.

| Installation and update history:

Looking forward to NJ SurvCon
2014

Looking forward to seeing old friends and meeting new ones at
the New Jersey SurvCon this week. I’'ll be teaching Field to
Finish and Surface Modeling with Carlson Survey on Wednesday
afternoon. Please stop by our booth to say ‘Hi’ and meet The
Other CAD Girl.
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Did You Know.. About Carlson’s
Export to KMZ (Google Earth)
Command?

Carlson Software gives you the ability to export drawing
entities directly to the Google Earth application or,
alternatively, to a .kml or .kmz file that can be opened in
Google Earth. At this time Carlson supports the export of
points, polylines, text, solids, images, lines and arcs to
Google Earth or .kml/.kmz files.

In Carlson 2014 they have also included the option of sending
the Google Earth file directly to a Dropbox account for sharing
with clients or other project team members.

The Export to Google Earth command is found in the File menu in
all Carlson desktop programs.


https://thatcadgirl.com/2013/11/did-you-know-about-carlsons-export-to-kmz-google-earth-command/
https://thatcadgirl.com/2013/11/did-you-know-about-carlsons-export-to-kmz-google-earth-command/
https://thatcadgirl.com/2013/11/did-you-know-about-carlsons-export-to-kmz-google-earth-command/
http://thatcadgirl.com/all-carlson-software/
https://www.dropbox.com/

ﬁ Export to KML/KMZ

Elevation Option Opacity Options

(@) Drape on Google Terrain (2D)

(") Use Elevation from the Drawing (30
Export Options

Include Selected Points

| JInclude Selected Text

Include Layer Information

|| shade Closed Regions

Include Solids and Images

Export to KMZ Format Linework Opacity = 100%
Display Results in Google Earth

|| Share Results through Dropbox

y

Solids and Images Opacity = 100%

Year End Specials for Carlson
Software

Updated 11/4/2013: I've just added several more end of year
specials for Survey with IntelliCAD, Takeoff Suite,
Construction, Trench, GeoTech, Survey with IntelliCAD and
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manuals and more.. Remember to Add Coupon for best pricing!

Carlson jumped the gun a bit and announced their year-end
specials today.. Special pricing will end at noon on 12/31/2013.
In addition, all software purchases through 12/31 include 2
hours of online training.

Check out my online store and make sure to pick the item’s “Add
Coupon” button for best pricing:

Carlson Civil Suite including one year of upgrades/maintenance

Carlson Survey 2014 with embedded AutoCAD

Carlson CADNet 2014 including one year of upgrades/maintenance

CADNet is a new module for 2014 — broken out of Takeoff. CADNet
has tools for digitizing, importing raster and vector data from
images and PDFs, merging two image files, BIM data and more.
Check out this recent webinar introducing Carlson CADNet to see
how powerful it 1is.

End of Year Workshops — New
format for 2013

After several years of the same format for our end of year
workshops, we’ve changed it up a bit this year.

For the first time, we will have one full day in both
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Statesville and Raleigh NC dedicated to Surveying and GIS topics
and an additional day focusing on Civil and Hydrology topics.
Each day will also include a unique presentation of the popular
CAD Tips & Tricks session that, hopefully, sends everyone home
with something they can use the next day.

In addition, we’re conducting 1/2-day events in Wilmington and
Hendersonville (Asheville area) covering a variety of topics.

Each full-day class will give NC licensed surveyors and
engineers 8 PDH credits and the 1/2 day events are eligible for
4 PDH credits. All events include lunch, software pricing
specials and giveaways.

November 11th, Hendersonville NC — $49 for 4 PDH credits
Download Hendersonville (Asheville) Announcement Here
Register for Hendersonville (Asheville) Workshop Here

November 12th, Survey & GIS Workshop, Statesville NC — $99 for 8
PDH credits

Download Statesville Survey/GIS Announcement Here

Register for Statesville Survey/GIS Workshop Here

November 13th, Civil & Hydrology Workshop, Statesville NC — $99
for 8 PDH credits

Download Statesville Civil/Hydro Announcement Here

Register for Statesville Civil/Hydro Workshop Here

December 9th, Wilmington NC — $49 for 4 PDH credits
Download Wilmington Announcement Here
Register for Wilmington Workshop Here

December 11th, Survey & GIS Workshop, Raleigh NC — $99 for 8 PDH
credits

($89 registration thru 10/31/2013)

Download Raleigh Survey/GIS Announcement Here
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Register for Raleigh Survey/GIS Workshop Here

December 12th, Civil & Hydrology Workshop, Raleigh NC — $99 for
8 PDH credits

($89 registration thru 10/31/2013)

Download Raleigh Civil/Hydro Announcement Here

Register for Raleigh Civil/Hydro Workshop Here

Carlson 2014 Has Been Released

Carlson released the 2014 version of their desktop products
today. This includes: Civil Suite, Civil, Survey, Hydrology,
GIS, Takeoff Suite, Construction, Point Cloud, Geology,
Surface/Underground Mining and Natural Regrade.

The 2014 embedded-AutoCAD versions of Takeoff Suite and Survey
have not yet been released.

Carlson Desktop products include IntelliCAD 7.2b and can run on
top of full AutoCAD-based products versions 2004-2014. This
includes AutoCAD, Map, Land Desktop and Civil 3d. Also, anyone
using the FREE IntelliCAD that comes with Carlson is still
eligible for a FREE GIS Starter Kit from Esri which includes
ArcMap. [This offer ended on 12/31/2013]

You can download Carlson 2014 here.
View the “Survey and Civil — What'’s new in 2014” webinar here

If you are using 2013 and are current on your annual maintenance
contract, you can click here to look up your new 2014 serial number online. You
will need to enter your contact information and your 2013 serial
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number in order to generate the 2014 serial number. You can find
your serial number by opening Carlson Software and going to Help
> About Carlson Software > Change Registration.

If you have trouble finding your serial number or would like to
know the cost to upgrade any product to 2014, please email me
with your request.

Click here for the full list of improvements in Carlson 2014
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